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Need help? 

If you cannot find answers in this document or the FAQs 
(http://www.ca9.uscourts.gov/cmecf/faqs/), you can submit a question at 
http://www.ca9.uscourts.gov/cmecf/feedback/. You can expect a reply from the Court during 
the Court's business hours, from 8:30 AM to 5:00 PM Pacific Time. 

You can also request in-person training using this form: 
http://www.ca9.uscourts.gov/cmecf/trainingreq/. 
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Technical Requirements 

Email Account 
The size of your email account must be sufficient to receive NDAs. This may exceed the size allocated for free 
email accounts. In general, an account with storage space of at least 100 megabytes is sufficient.  

You must ensure that the spam filter operation on the network and computer receiving the email are set to 
allow notices from ca9_ecfnoticing@ca9.uscourts.gov. Ideally, you should allow email messages from the 
ca9.uscourts.gov domain to ensure that you will also see messages sent to you by our help desk 
(cmecf_ca9help@ca9.uscourts.gov). 

Internet Connection 
A cable modem or digital subscriber line (DSL) is recommended. A dial up connection is technically feasible, 
but it will be too slow for most users. 

Word Processing Software 
You can use any word processing software that will allow you to convert text documents to PDF. 

Searchable PDF Files 
All documents must be submitted in Portable Document Format (“PDF”). The version filed with the Court must 
be generated from the original word processing file to permit the electronic version of the document to be 
searched and copied. PDF files created by scanning paper documents are prohibited; however, exhibits 
submitted as attachments to a document may be scanned and attached if you do not possess a word 
processing file version of the attachment.  

You can create searchable PDF files by printing the document to a PDF printer. If you do not see a PDF printer 
among your list of printers, you must download one. There are many free programs available (in any Internet 
search engine, type in “print to pdf” or “word to pdf”). The Court does not recommend any one program, but 
we find CutePDF easy to use. Once you download and install the program, you should be able to select the 
PDF printer from your list of printers. 

If you are using a trial version of a product, make sure that the PDF does not contain marks or logos with links 
to the site of the company that developed the product. The Court will not accept PDF files with such marks or 
logos.  

Scanner 
Paper documents may be scanned and attached if you do not possess a word processing file version of the 
attachment. Such documents should be scanned into PDF at 300 - 600 pixels per inch (PPI), with a “black and 
white” setting.  

You may not scan your pleadings; they must be in searchable PDF format created directly from your word 
processing application. 

Pop-Up Blocker 
To use CM/ECF, the pop-up blocker in your browser must either be turned off or set to allow pop-ups from 
*.ca9.uscourts.gov. This is required because the Notice of Docket Activity page that confirms your filing 
opens in a new browser window or tab (which is considered a pop-up) at the end of your transaction. 
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Getting Started with CM/ECF 
The topics below provide information that you may find useful when using CM/ECF in the United States Court 
of Appeals for the Ninth Circuit for the first time. 

CAUTION: The case numbers shown in the images in this document are test case numbers and they are not 
representative of real case numbers in the Court. All case numbers start with a two-digit year, followed by a 
hyphen and a five-digit number. 

Starting CM/ECF 
You log in to CM/ECF at PACER, using your PACER login. 

1. Open a web browser window and navigate to the following URL: 
https://ecf.ca9.uscourts.gov/n/AttorneyFiling/login.jsf  
 
The PACER LOGIN page opens.  

2. Enter your PACER login and password. 
 
NOTE: If you do not have a PACER login, you must create a new account. Click the Need an Account? link 
under the Login box and follow the instructions. Once you have created a PACER login, you will be able to 
link your filing login with the PACER login. Going forward, you will only use your PACER login. Visit the 
PACER website at http://www.pacer.gov/ for more information. 

3. In the Redaction Agreement dialog box that opens, select the checkbox to acknowledge edge that you 
have read the redaction agreement. 
 
As soon as you select the checkbox, the Continue button is enabled. 

4. Click the Continue button. 
 
The CM/ECF landing page opens and you can now start filing. 

About the CM/ECF Landing Page 
The CM/ECF landing page has the following elements:  

• (a) The CM/ECF logo in the upper left corner of the page.  
 
TIP: Click this logo at any time to return “home” (the CM/ECF landing page). 

• (b) The menu bar, with menus that contain menu items or commands. 
 
(c) In the illustration below, Filing, Reports, Utilities, Logout, Help, and Getting Started are menus.  
History Report, PACER Report, and Service List are menu items or commands. 

• (d) A court identification in the upper right corner of the page. 

• (e) The message area, where the Court posts messages about system downtime. 
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Logging Out of CM/ECF 
To ensure that someone else using your computer cannot enter filings using your login, make sure you log out 
of CM/ECF. When you log out of CM/ECF, you will also be logged out of PACER. 

1. In the CM/ECF page, in the menu bar, click Logout. 
A Confirm Logout dialog box opens. 

2. Click the OK button. 
CM/ECF closes and the PACER LOGIN page opens. 
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Submitting Original Petitions With Fee Payment 
You can submit electronic versions of original petitions (such as petitions for review, petitions for writ of 
mandamus, and petitions for permission to appeal) and, if a fee is required, you can pay the filing fee using 
your credit card. If you use this feature, there is no need to send a paper original to the court.  

NOTE: Although your submitted documents will be deemed received as of the date submitted, the court may 
not open your case or create a docket number until the next business day.  

CAUTION: If you need relief or verification of your submission before the next business day because of an 
imminent removal or deportation or because emergency relief is needed for some other reason you must call 
the court at (415) 355-8020.  

Before you start, make sure you have all the PDF files ready to upload. 

NOTE: All attached documents must be searchable and must be accompanied by proof of service by mail or 
other method of service by the filer directly (no electronic service through CM/ECF).  

3. In the CM/ECF landing page, in the menu bar, click Utilities, then click Submit New Case With Fee 
Payment, then choose the appropriate option: 

• Agency or Immigration Petition (Fee) 

• Petition for Writ of Mandamus (Fee) 

The CM/ECF landing page is replaced with a new page. The title depends on your selection. An example is 
shown below for Submit New Case With Fee Payment > Agency or Immigration Petition (Fee). 
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4. In the Submit Documents area, do the following for each PDF you want to attach to the submission: 

a. In the Description field, accept the default description or type your own description for the PDF. 

b. Click the Browse button. 
 
The File Upload document dialog box opens. By default, the File Upload document dialog box points to 
the last location you accessed to attach documents from within CM/ECF. 

c. Navigate to and select the PDF file you want to attach. 

d. Click the Open button. 

The File Upload dialog box closes and CM/ECF shows the file you selected in the list of documents. 
 
NOTE: Remember to include a certificate of service.  

5. Click the Pay Fee and Submit button to submit your payment and the case opening materials you 
attached. 
 
The page where you clicked the Pay Fee and Submit button is replaced with a PACER Login page. Your 
username is already filled in. You must enter your password again to confirm your identity. This is a safety 
measure. An example of the PACER Login page is shown below. 
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6. In the Password field, type your password, then click the Login button. 
 
The PACER page is updated to show the Pay Other Court Fees for U.S. Court of Appeals, Ninth Circuit - 
NextGen area, where you can select a credit card on file, or enter a new credit card. An example is shown 
below. 
 

 
 

7. Under Select a Payment Method, select the option button for the card you have on file with PACER or 
select the Enter a credit card option button and click the Next button. 
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8. If you chose the Enter a credit card option button, enter the information needed for the credit card, then 
click the Next button.  
 
The page is updated to show fields specific to the U.S. Court of Appeals, Ninth Circuit. Those fields are 
shown below. 
 

 
 

9. Under Court Specific, complete the required fields.  
 
NOTE: When you are submitting new case materials, you do not have a case number yet, so the Case 
Number field is optional.  

10. Under Email Receipt, if you want the confirmation email to be sent to a different email address than the 
one linked to your PACER and e-filing account, enter that email address in the Email and Confirm Email 
fields.  
 
Optionally, if you want the receipt to be sent to other email addresses, enter those email addresses in the 
Additional Email Addresses field, each email separated by a comma or a space. An example is shown 
below. 
 

 
 

11. Under Authorization, select the checkbox to authorize the charge on the credit card. 
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12. Click the Submit button. 
 
PACER processes the payment, and when it is complete, a receipt is shown. An example of a receipt is 
shown below. 
 

 
 

13. Make sure you review what you just submitted to avoid duplicate submissions and/or duplicate payments. 
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Submitting Original Petitions Without Fee Payment 
You can submit electronic versions of original petitions (such as petitions for review, petitions for writ of 
mandamus, and petitions for permission to appeal). If you use this feature, there is no need to send a paper 
original to the court.  

Before you start, make sure you have all the PDF files ready to upload. All attached documents must be 
searchable and must be accompanied by proof of service by mail or other method of service by the filer 
directly (no electronic service through CM/ECF).  

1. In the CM/ECF landing page, in the menu bar, click Utilities, then click Submit New Case Without Fee 
Payment, then choose the appropriate option: 

• Agency or Immigration Petition 

• Petition for Writ of Mandamus 

• 1292(b) Petition 

• 1453(c) Petition 

• 158(d) Petition 

• 23(f) Petition 

• Second or Successive Habeas Petition 

The CM/ECF landing page is replaced with a new page. The title depends on your selection. An example is 
shown below for Submit New Case With Fee Payment > Petition for Writ of Mandamus. 
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2. In the Submit Documents area, do the following for each PDF you want to attach to the submission: 

a. In the Description field, accept the default description or type your own description for the PDF. 

b. Click the Browse button. 
 
The File Upload document dialog box opens. By default, the File Upload document dialog box points to 
the last location you accessed to attach documents from within CM/ECF. 

c. Navigate to and select the PDF file you want to attach. 

d. Click the Open button. 

The File Upload dialog box closes and CM/ECF shows the file you selected in the list of documents. 
 
NOTE: Remember to include a certificate of service.  

3. Click the Submit button. 
 
The system uploads the PDF files you attached, and when the process is complete, the page is updated to 
show you a completion message. An example of that message is highlighted in the following illustration. 
 

 
 

4. Make sure you review what you just submitted to avoid duplicate submissions and/or duplicate payments. 
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Reviewing Your Submissions and Payments 
You can review a history of the original petitions you submitted and the payments you made. 

• In the CM/ECF landing page, in the menu bar, click Reports then click History Report. 
 
A new browser window or browser tab opens with the report. A sample report is shown below. 

NOTE: This report shows a history of the PDF files you submitted using the options under the Utilities menu. 
This report does not show a history of filings or submissions you did in cases via the Filing menu, except fee 
payments. 
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Checking the Service List 
Before you submit any filing in CM/ECF, make sure you review the service list for the case or cases so you 
know which attorneys or parties to serve by US Mail. You can check the service list for a case at any time. 

CAUTION: Service rules are different for sealed documents. See the Filing a Sealed Document section for 
details. 

TIP: If you find that you cannot access the service list for a case, a pop-up blocker may be at work in your 
browser. The best way to check is to turn on the sound on your system, then try to access the Service List 
(Reports > Service List) or the Help (Help > Help), you should hear a distinctive “ding” which indicates that 
there is something blocking a web page from opening. Make sure you change the pop-up blocker settings to 
allow all pop-ups from our site (ecf.ca9.uscourts.gov). 

1. In the CM/ECF landing page, in the menu bar, click Reports, then click Service List. 
 
A new browser window or page opens. An example of what appears in the page is shown below. 
 

 
 

2. In the Case Number field, type the case number. 
 
NOTE: The Include Associated Cases checkbox is selected by default. If you do not want to include 
associated cases, clear the checkbox. 
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3. Click the Show Service List button. 
 
The service list for the case is shown in the browser window. An example of the report is shown below. 
 
CAUTION: If you try to see the service list for a sealed case, the system will tell you that it cannot find the 
case. 
 

 
4. Check the values in the ECF Filing Status column to determine service for the participant. 

• Active: your electronic filing will constitute service to the participant. 

• Not Registered, Exempt, Pending, Rejected, or Suspended: you must serve the participant by US Mail. 

• Blank: you must serve the participant by US Mail 
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Filing: About the File a Document Page 
You start each filing at the File a Document page. To open the File a Document page, in the CM/ECF page, in 
the menu bar, click Filing. The File a Document page has the following parts: 

1. The Case Number field 
When you enter the case number and move your cursor out of the field, the system shows the case title. 

2. The Filed field 
You cannot change the value of this field. It is the filed date for the filing. 

3. The filing type and category lists 
You use these lists to select the type of document you are filing. 
You can type any word in the Type of Document box to find all matching filing types available to you. You 
can also filter the entries under Type of Document by selecting a filing category from the Category drop-
down list. 

4. The Parties/Attorneys panel 
This panel is populated by the system after you type a case number and move your cursor out of the Case 
Number field.  

 
In addition, a box labeled “The document will also be filed in cases that are checked” appears above the 
Continue button if the system determines that the case number you entered is linked to one or more other 
cases as consolidated cases or cross-appeal cases.  
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Case Title 
As soon as you type the case number in the Case Number field and move the cursor out of that field, the 
system retrieves the case information. The case title is shown next to the case number field where you 
entered the case number. An example is shown below. 

 

Parties/Attorneys Panel 
In the File a Document page, after you enter the case number, the system retrieves the party and attorney 
information for the case you entered and displays that information in the Parties/Attorneys panel on the right 
side of the page. The area is highlighted in the example below. 
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You can hide this panel by clicking the arrow button to the right of Parties/Attorneys, highlighted below. When 
you click the arrow button, the panel closes and the arrow button changes to an expand button that you can 
then click to show the panel again. 

NOTE: When you continue the filing, the Parties/Attorneys panel is automatically hidden. 
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Finding and Selecting a Filing Type 
The Continue button at the bottom of the File a Document page will not be enabled until you select the type 
of document you are filing. You select a filing type by clicking a row under Type of Document/Category. Use 
one of the methods below to find a filing type. 

• Scroll through the complete list using the scrollbar to find the type of document you want. 

• Filter the list of document types by typing a word or a partial word in the Type of Document field to find all 
filing types that match your search. In the example below, the list has been filtered to show only those 
filing types that contain the string “corr.” 

• Filter the list of document types by category by selecting a value from the Category drop-down list. You 
can then filter the results even further by typing a word or a partial word in the Type of Document field.  
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Filing in Consolidated or Cross-Appeal Cases 
In the File a Document page, after you enter the case number, the system retrieves all consolidated or cross-
appeal cases linked to the case you entered. Those cases are shown at the bottom of the File a Document 
page, under the filing type and category lists. In the example below, that area is highlighted. By default, you 
will enter your filing in all the linked cases, as shown in the figure below. 

CAUTION: By default, the linked cases are selected (checked). Do not clear (deselect) any checkboxes in this 
list since you are required to enter your filing in all consolidated and cross-appeal cases. 
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Starting a Filing 
You start a filing by opening the File a Document page.  

1. In the CM/ECF page, in the menu bar, click Filing. 

2. In the Case Number field, type the number of the case for which you are entering the filing and press the 
Tab key. 
 
You are now ready to find the filing type so you can enter your filing. 

3. In the Type of Document field, type a word or a string of characters that represents the pleading you are 
filing.  
 
For example, type “motion” to find all the document types that contain the word motion. 

4. Select the type of document you are filing. 
 
NOTE: If, after you have selected the type of document, other case numbers appear in the box labeled The 
document will also be filed in cases that are checked, they will all be selected by default. Your filing will 
be entered in the case that you typed in the Case Number field and the cases listed in The document will 
also be filed in cases that are checked. 

5. Click the Continue button. 
 
A warning dialog box opens.  

6. Carefully review the information in the dialog box. 
 
An example of a warning dialog box that opens when you submit a brief is shown below. 
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7. Select the Continue checkbox, and click the OK button 
 
The File a Document page is replaced with a new File a Document | Filing Type page. Filing Type is the 
type of document you selected on the first page, so if you selected “Motion for any Type of Relief (Other 
than Reconsideration or to Seal)”, the title of the page will be File a Document | Motion for any Type of 
Relief (Other than Reconsideration or to Seal).  
 
You will use this page and its sections to complete the details about the filing. 

8. Each time you click the Continue button, the page refreshes and one or more new sections are added to 
the page. 

9. When you have entered all the information for the filing, the Docket Text section is added to the page and 
shows the final docket text.  
 
An example of the docket text for a motion to extend time to file a reply brief is shown below. You cannot 
change the docket text.  
 
TIP: If you realize that you need to make changes to the filing, reopen the section(s) where you need to 
make corrections. You can also click the Cancel link at the bottom of the page to start over completely. 
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10. Click the Continue button. 
 
The Final Review section opens. An example of the lower part of the page at this stage in the filing process 
is shown below. 
 

 
 
CAUTION: This is the “point of no return.”  
 
TIP: If you realize that you need to make changes to the filing, click the Edit link to make your corrections. 
You can also click the Cancel link at the bottom of the page to start over completely. 
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11. Click the Submit button to confirm your filing. 
 
A message dialog box opens to let you know that the filing was completed.  
 
TIP: At this point, if you have not already done so, make sure your browser is set to allow pop-ups from the 
Court’s site: ecf.ca9.uscourts.gov, to ensure that you will see the notice of docket activity at the end 
of the filing process. 

12. Click the OK button. 
 
A browser window or tab opens with the notice of docket activity for your filing. An example is shown 
below. 
 

 
 
This completes the filing. 
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Selecting the Filing Party 
When you file a document, you must identify the parties that you represent in the appeal. If you are a pro se 
filer, you must identify yourself at this stage of the process. You identify the parties in the Party Filer section.  

Depending on the filing type the Party Filer list shows: 

• Only the party or parties you represent in the case(s) where you are entering the filing, or, if you are a pro 
se filer, your name. 

• All the parties in the case(s) where you are entering the filing. You will see a complete list of parties when 
you submit a brief. 

You select the party you represent (or yourself if you are proceeding pro se) by clicking the party in the list. As 
soon as you click the row, the system adds the party to the Selected list in the Party Filer section, as shown 
below. 

NOTE: If you represent more than one party, you can select additional parties to add them to the Selected list. 
In this example, only one party is selected because the attorney entering the filing represents one party, ABC, 
in both cases. The Selected list shows one row for each case in which the party appears. 
If you are a pro se filer, click your name in the list.  

 
TIP: You can use the Remove All link in the Selected list to remove all the selections from the Selected list. You 
can also click the red “X” icon to remove just one party from the list. 

Filing Joint Documents 
If you are filing a joint brief, select all the parties who joined in the brief. 
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Selecting Reliefs for a Filing 
When you file a motion, you must select at least one relief. A relief describes your motion for the Court. You 
select reliefs in the Requested Relief section. If the section is not visible, use the scroll bar on the right of the 
page to scroll down until you see the section. 

The Relief field in the Requested Relief section works like the Type of Document field on the first File a 
Document page. You can filter the list by typing in the Relief field. 

For example, in the Relief field, type “extend time” to find all reliefs that contain the string “extend time” in 
the description. 

The system filters the list to match your criteria, as shown below. Notice that each of the reliefs contain the 
words “extend time” and that the scroll bar is now enabled in the list of reliefs. This means that there are 
more reliefs than the ones currently shown. 
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To select a relief, click the relief in the list. As soon as you click the row, the system adds the relief to the 
Selected list in the Requested Relief section. An example for motion to extend time to file brief is shown 
below. 

 
TIP: You can use the Remove All link in the Selected list to remove all the selections from the Selected list. You 
can also click the red “X” icon to remove just one relief from the list. 
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Selecting Related Entries for a Filing 
In some types of filings, such as responses, you may be required to select the entry to which your filing 
applies. You do this using the Related Entries section. 

The image below shows an example of the Related Entries section without any selections. You can click the 
document or lock icon in the Doc column to see the document that is attached to the entry on the Court’s 
docket.  

NOTE: A lock icon instead of a document icon in the Doc column means that the document or documents 
attached to the filing are visible only to case participants. 
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To select a related entry, click that entry in the list. As soon as you click the row, the system adds the entry to 
the Selected list in the Related Entries section. An example for a related motion to extend time to file brief is 
shown below. 

 
TIP: You can use the Remove All link in the Selected list to remove all the selections from the Selected list. You 
can also click the red “X” icon to remove just one relief from the list. 
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Required Fields 
The system will always prevent you from continuing if you do not complete required fields.  

Drop-down Lists 
If a drop-down list in a filing has a default value of Please Select, then you must select a value from that drop-
down list. If you do not select a value, you will not be able to continue the filing.  
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Saving a Completed Fill-In Form 
You can download fill-in forms from the Court’s website at http://www.ca9.uscourts.gov/forms.  

You cannot file fill-in forms that can still be changed. You must “flatten” the form by using one of the solutions 
below. 

If you have Adobe Acrobat or another tool that lets you save completed forms: 
1. Go to http://www.ca9.uscourts.gov/forms and save the form to your hard drive.  

2. Open and complete the form. 

3. Print the completed form to your PDF printer (File > Print > select Adobe PDF or another PDF printer listed 
in the drop-down list). 

If you do not have Adobe Acrobat or another tool that lets you save completed forms: 
1. Go to http://www.ca9.uscourts.gov/forms and save the form to your hard drive.  

2. Open and complete the form. 

3. Print the completed form to your printer. 

4. Scan the completed form to a PDF file. 

http://www.ca9.uscourts.gov/forms
http://www.ca9.uscourts.gov/forms
http://www.ca9.uscourts.gov/forms
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Checking a PDF File Before Filing 
CM/ECF lets you check your PDF file(s) to ensure they will be accepted by the system when you enter your 
filing. The system no longer accepts forms with active content. This means that for all fillable forms, you must 
“flatten” the form before you attempt to attach it to your filing.  

1. In the CM/ECF landing page, in the menu bar, click Utilities then click Check PDF Document. 
 
The CM/ECF landing page is replaced with the Check PDF Document page shown below. 
 

 
 

2. Click the Browse button to select a PDF document to check. 
 
The File Upload dialog box opens. By default, this dialog box points to the last location you accessed to 
attach documents from within CM/ECF. 

3. Navigate to and select the file (PDF) you want to check. 
 
CAUTION:  The File Upload dialog box lists files of all types. Make sure you select a PDF file. 

4. Click the Open button. 
 
The dialog box where you selected the PDF closes and the system runs the check in the background. When 
the check is complete, a message box opens with the results.  
 
If the file passes the check, you will see the message box shown below. Otherwise, you will see an error 
message. Other possible error messages are described below. 
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PDF Error: File Too Large 
If the file is too large, you will see the error message shown below. In this case, you will have to split your PDF 
into parts that are not larger than the limit mentioned in the error message. This should only happen for 
scanned documents, not your main pleading. Your main pleading must be in searchable PDF created directly 
from your word processing application, not scanned. 

 

PDF Error: File Contains Active Content 
If the file has active content (a script or something else that may affect security in the CM/ECF system), you 
will see the error message shown below. To fix this issue, you will have to “flatten” the PDF to remove any 
active content. Consult the documentation for the software you used to create the PDF file. 

 



CM/ECF USER GUIDE 

36 

Attaching PDF Documents to Filings 
You attach documents to a filing using the Upload Documents section, highlighted in the image below. 

NOTE: For filing types where you do not attach a PDF, if you must serve parties that are not registered for 
Appellate Electronic Filing, print the Notice of Docket Activity that opens at the end of the transaction and 
mail it to those parties as notice of your filing.  

CAUTION: Each PDF that you attach to your filing may not exceed the current size limit (at the CM/ECF landing 
page, click the Court Information link to see the current size limit). All your pleadings must be in searchable 
PDF format, per Circuit Rule 25-5. 

 
For each document that you want to attach to the filing, do the following: 

1. In the Description field, accept the default description (Main Document or Additional Document) or type 
your own description for each document. 
 
CAUTION: Do not change the description for briefs, leave the default description, Main Document. 
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2. Click the Browse button to find and select the PDF file to attach. 
 
Make sure you upload all the PDF files that make up your filing (for example, a motion and a declaration). 
An example of the Upload Documents section, with two PDF files is shown below. 

 
TIP: You can click the document name link in the Document column to review the PDF and make sure you 
attached the correct document. You can also click in the Description field to change the description, but unless 
the instructions in the filing request that you change the description, the court requests that you do not 
modify the default values. 
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Paying the Case Opening Fee 
If you filed an Agency Petition, a Petition for Writ of Mandamus, or an appeal from the Bankruptcy Appellate 
panel, and you have a 9th Circuit case number, can pay the filing fee using CM/ECF and a credit card.  

However, if you filed a Notice of Appeal in the District Court, the Bankruptcy Court, or the Tax Court, you must 
pay the filing and appeal fees in that court.  

1. In the CM/ECF landing page, in the menu bar, click Filing. 
 
The File a Document page replaces the CM/ECF landing page. 

2. In the Case Number field, type the number of the case for which you are paying the fee and press the Tab 
key. 
 
You are now ready to find the filing type for the payment. 

3. In the Type of Document field, type pay to find all document types that contain the string “pay” in the 
description. 
 
The system filters the list to match your criteria, as shown below. 
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4. If you are paying the filing fee for an agency petition or a petition for writ of mandamus, click Pay Fee for 
Agency Petition/Petition for Writ of Mandamus to select it. 
-or- 
If you are paying the filing fee for an appeal from the Bankruptcy Appellate Panel, click Pay Fee for Appeal 
from Bankruptcy Appellate Panel to select it. 
 
The type of document you selected is highlighted in a different color to show that it is selected and the 
Continue button is now enabled. An example, for Pay Fee for Agency Petition/Petition for Writ of 
Mandamus, is shown below. 
 

 
 

5. Click the Continue button. 
 
The page refreshes to add several sections to the page. 
 
NOTE: If you selected Pay Fee for Agency Petition/Petition for Writ of Mandamus and the case is not an 
agency petition or a petition for writ of mandamus, a message dialog box opens and you will not be able to 
continue. 
-or- 
If you selected Pay Fee for Appeal from Bankruptcy Appellate Panel and the case is not an appeal from 
the BAP, a message dialog box opens and you will not be able to continue. 
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6. In the Party Filer section, select the party/parties you represent by clicking each party in the list. 
 
As soon as you click the row, the system adds the party to the Selected list in the Party Filer section. At 
this time, the page should look like the one shown below. 
 
NOTE: If you represent more than one party, you can select additional parties to add them to the Selected 
list. In this example, you are only selecting one party. If you are a pro se filer, click your name in the list. 
 

 
 
NOTE: The Attention section below the Fee section describes the steps that are described in the rest of 
this topic. 
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7. Click the Continue button. 
 
The Docket Text section is added to the page and shows the current docket text. An example of the docket 
text for the payment of a case opening fee for an original petition is shown below. You cannot change the 
docket text. 
 

 
 

8. Click the Continue button. 
 
The Final Review section opens. An example of the lower part of the page at this stage in the filing process 
is shown below. 
 
NOTE: The receipt number for the payment will be added to the docket text after you have completed the 
payment. 
 

 



CM/ECF USER GUIDE 

42 

9. Click the Pay Fee button to submit your payment. 
 
The page where you clicked the Pay Fee button is replaced with a PACER Login page. Your username is 
already filled in. You must enter your password again to confirm your identity. This is a safety measure. An 
example of the PACER Login page is shown below. 
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10. In the Password field, type your password, then click the Login button. 
 
The PACER page is updated to show the Pay Filing Fees for U.S. Court of Appeals, Ninth Circuit - NextGen 
area, where you can select a credit card on file, or enter a new credit card. An example is shown below. 
 

 
 

11. Select a payment method: 

a. Under Select a Payment Method, select the option button for the card on file or select the Enter a 
credit card option button and click the Next button. 

b. If you selected to enter a new credit card, enter the information needed for the credit card, then click 
the Next button. 
 
The page is updated to show fields specific to the U.S. Court of Appeals, Ninth Circuit in the Court 
Specific section. 

12. Provide additional information and indicate where you want to receive a receipt: 

a. Under Court Specific, complete the required fields: Attorney Name, Contact Telephone Number, and 
Person Completing Transaction. 
 
NOTE: Even though the Case Number is optional, it helps to provide the appellate case number to 
assist the Court in case payment issues arise. 

b. Under Email Receipt, if you want the confirmation email to be sent to a different email address than 
the one linked to your PACER and e-filing account, enter that email address in the Email and Confirm 
Email fields. If you want a confirmation email to be sent to additional, other email addresses, enter 
those email addresses in the Additional Email Addresses field. Separate each email address with a 
comma. 
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13. Under Authorization, select the checkbox to authorize the charge on the credit card. 
 
TIP: At this point, if you have not already done so, make sure your browser is set to allow pop-ups from the 
Court’s site: ecf.ca9.uscourts.gov, to ensure that you will see the notice of docket activity at the 
end of the filing process. 

14. Click the Submit button. 
 
PACER processes the payment, and when it is complete, you are redirected to CM/ECF where you can print 
the payment receipt. An example of a receipt is shown below. 
 

 
 

15. Click the OK button. 
 
A browser window or tab opens with the notice of docket activity for your fee payment filing. The docket 
text now includes the receipt number for the payment. 
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Submitting a Brief for Review by the Court 
Before you start, make sure you review the information in “An Overview of Filing,” to familiarize yourself with 
the process of filing something in CM/ECF. 

CAUTION: You may not file a motion in the same transaction as the one you submit for your brief, and you 
may not attach excerpts to a brief submission. To file a motion at the same time as your brief or excerpts of 
record, file your motion first (see Filing a Motion) then submit your brief (instructions in this topic) and/or 
then your excerpts of record in a separate transaction (see Submitting Excerpts of Record for Review by the 
Court). If you are filing a motion, submitting briefs, and submitting excerpts, you must enter three filings 
(transactions) in the system. 

1. In the CM/ECF landing page, in the menu bar, click Filing. 

2. In the File a Document page, in the Case Number field, type the number of the case for which you are 
entering the filing and press the Tab key. 
 
The system now shows the case title next to the Case Number field and populates the Parties/Attorneys 
panel (on the right).  

3. In the Type of Document field, type the word “brief” to find all document types that contain the string 
“brief” in the description. 
 
The system filters the list to match your criteria, as shown below. Notice that each of the filing types 
contain the word “brief.” You could filter the list even further by selecting a value from the Category drop-
down list. 
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4. Click Brief on the Merits (Opening, Answering, Reply, Supplemental, etc) to select it. 
 
The type of document you selected is highlighted in a different color to show that it is selected. An 
example is shown below. 
 
NOTE: By default, the system selects all the linked cases (consolidated and cross-appeals) in the box 
labeled The document will also be filed in cases that are checked. This means that the filing will 
automatically be entered in those linked cases. 
 

 
 

5. Click the Continue button. 
 
A warning dialog box opens. 
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6. Carefully review the information in the dialog box, select the Continue checkbox, and click the OK button. 
 
The File a Document | Brief on the Merits (Opening, Answering, Reply, Supplemental, etc) page opens. An 
example is shown below. 
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7. In the Party Filer section, select the party you represent by clicking the party in the list.  
 
As soon as you click the row, the system adds the party to the Selected list in the Party Filer section, as 
shown below.  
 
NOTE: If you represent more than one party, you can select additional parties to add them to the Selected 
list. In this example, only one party is selected because the attorney entering the filing represents one 
party, ABC, in both cases. The Selected list shows one row for each case in which the party appears. If you 
are a pro se filer, click your name in the list. 
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8. In the Type of Brief section, select the type of brief you are submitting.  
 
In this example, we have selected Reply Brief from the drop-down list, as shown below.  
 

 
 

9. Scroll down to the Upload Documents section and for each document that you want to attach to the filing, 
do the following: 

a. In the Description field, always accept the default description (Main Document) for the brief itself. 

b. Click the Browse button to find and select the PDF file to attach. 
Make sure you upload all the documents that make up your filing (for example, brief and appendices). 
There is no limit to the number of files you can attach. Do not change the default description for the 
documents. An example of the Upload Documents section, with two PDF files is shown below. 

REMINDER: You must submit the excerpts of record in a separate filing. Use Excerpts of Record to submit 
the excerpts. 
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10. In the Service section, in the date field, type the service date for the filing, and in the Service Certification 
section, from the drop-down list, select the value that certifies that you notified all parties not registered 
for electronic filing with notice of the filing.  
 
An example is shown below. 
 

 
 

11. Click the Continue button.  
 
The Docket Text section is added to the page and shows the final docket text. An example of the docket 
text for the submission of a brief is shown below. You cannot change the docket text.  
 
TIP: If you realize that you need to make changes to the filing, reopen the section(s) where you need to 
make corrections. You can also click the Cancel link at the bottom of the page to start over completely. 
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12. Click the Continue button. 
 
The Final Review section opens. This is the “point of no return.”  
 
TIP: If you realize that you need to make changes to the filing, click the Edit link to make your corrections. 
You can also click the Cancel link at the bottom of the page to start over completely. 

13. Click the Submit button to confirm your filing. 
 
A message dialog box opens to let you know that the filing was completed.  

14. Click the OK button. 
 
A browser window or tab opens with the notice of docket activity for your filing. An example is shown 
below. 
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Submitting Excerpts of Record for Review by the Court 
Before you start, make sure you review the information in “An Overview of Filing,” to familiarize yourself with 
the process of filing something in CM/ECF. 

CAUTION: If you want to submit any part of the excerpts of record under seal, you must—in a separate 
transaction along with the sealed volume of excerpts containing only the sealed documents—file a motion or 
a notice under Circuit Rule 27-13 (see the Rules page at http://www.ca9.uscourts.gov for the rule). See Filing a 
Sealed Document for details about sealed filings. The Sealed Filings FAQ on the Court’s website at 
http://www.ca9.uscourts.gov/cmecf/faqs/sealedfilings/ should answer any remaining filing-related questions 
you may have. 

1. In the CM/ECF landing page, in the menu bar, click Filing. 

2. In the File a Document page, in the Case Number field, type the number of the case for which you are 
entering the filing and press the Tab key. 
 
The system now shows the case title next to the Case Number field and populates the Parties/Attorneys 
panel (on the right).  

3. In the Type of Document field, type excerpt to find all document types that contain the string “excerpt” 
in the description. 
 
The system filters the list to match your criteria, as shown below. Notice that there is only one filing type 
that contains the word “excerpt.”  
 

 
 

4. Click Excerpts of Record and click the Continue button.  

5. Carefully review the information in the warning dialog box that opens, select the Continue checkbox, and 
click the OK button. 
 
The File a Document | Excerpts of Record page opens. It has additional fields to allow you to continue the 
filing. 

6. In the Party Filer section, select the party you represent by clicking the party in the list.  

http://www.ca9.uscourts.gov/cmecf/faqs/sealedfilings/


CM/ECF USER GUIDE 

53 

7. In the Type of Excerpts section, from the drop-down list, select the type that corresponds to the excerpts 
you are submitting: excerpts of record, supplemental excerpts of record, or further excerpts of record.  
 
An example of the drop-down list with the types of excerpts is shown below. 
 

 
8. Scroll down to the Upload Documents section and for each document that you want to attach to the filing, 

do the following:  

a. In the Description field, for each volume of excerpts, change the default description to ER Vol followed 
by the volume number (for example, ER Vol 1).  If you need to upload one volume in separate PDF files, 
indicate that in the description by adding a part number, for example, ER Vol 1 Part 1.  

b. Click the Browse button to find and select the PDF file to attach.  

Make sure you upload all the documents that make up your filing (for example, all the volumes of the 
excerpts of record).  
There is no limit to the number of files you can attach. An example of the Upload Documents section, with 
two PDF files is shown below.  
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9. In the Service section, in the date field, type the service date for the filing, and in the Service Certification 
section, from the drop-down list, select the value that certifies that you notified all parties not registered 
for electronic filing with notice of the filing.  
 
An example is shown below. You cannot continue your filing unless you select a value in the Service 
Certification section. 
 

 
 

10. Click the Continue button.  
 
The Docket Text section is added to the page and shows the final docket text. You cannot change the 
docket text.  
 
TIP: If you realize that you need to make changes to the filing, reopen the section(s) where you need to 
make corrections. You can also click the Cancel link at the bottom of the page to start over completely. 

11. Click the Continue button.  
 
The Final Review section opens. This is the “point of no return.” 

12. Click the Submit button to confirm your filing.  
 
A message dialog box opens to let you know that the filing was completed.  

13. Click the OK button.  
 
A browser window or tab opens with the notice of docket activity for your filing.  
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Filing a Motion 
This topic describes the steps for filing an unopposed motion to extend time to file an answering brief and is 
intended to give you a quick overview of the steps you need to complete to file a motion.  

1. In the CM/ECF landing page, in the menu bar, click Filing. 

2. In the File a Document page, in the Case Number field, type the number of the case for which you are 
entering the filing and press the Tab key. 

3. In the Type of Document field, type motion to find all document types that contain the string “motion” 
in the description. 
 
An example of the result is shown below. 
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4. Click Motion for any Type of Relief (Other than Reconsideration or to Seal) to select it. 
 
The type of document you selected is highlighted in a different color to show that it is selected. An 
example, for Motion for any Type of Relief (Other than Reconsideration or to Seal), is shown below. 
 

 
 

5. Click the Continue button. 
 
A warning dialog box opens. An example of a warning dialog box that opens when you file a motion is 
shown below. 
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6. Carefully review the information in the dialog box, select the Continue checkbox, and click the OK button. 
 
The File a Document | Motion for Any Type of Relief (Other Than Reconsideration or to Seal) page 
opens. It has additional fields divided into sections to allow you to enter details for the filing.  

7. In the Party Filer section, select the party you represent by clicking the party in the list. 
 
As soon as you click the row, the system adds the party to the Selected list in the Party Filer section. 

8. In the Optional Modifier For Motion section, select Unopposed from the drop-down list, as shown below. 
 

 
 

9. Scroll down to the Requested Relief section and in the Relief field, type extend time to find all reliefs 
that contain the string “extend time” in the description. 
 
The system filters the list to match your criteria. Notice that each matching relief contains the words 
“extend time’” You will also notice that the scroll bar is enabled in the list of reliefs. This means that there 
are more reliefs than the ones currently shown. 
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10. Use the scroll bar in the relief list until you see “motion to extend time to file brief” in the list, then click 
motion to extend time to file brief. 
 
As soon as you click the row, the system adds the relief to the Selected list in the Requested Relief section, 
as shown below. 
 

 
 
You can repeat this step for other reliefs. You may select more than one relief for a motion. In this 
example, only one relief is selected. 

11. Click the Continue button at the bottom of the page. 
 
The system collapses the completed sections and adds new sections that you must complete to continue. 
You can reopen a section by clicking the arrow to the left of the label for the section. 
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12. In the Type of Brief section, select Reply from the drop-down list and in the New Requested Due Date, 
type the new due date you are requesting, as shown below.  
 

 
 

13. Scroll down until you can see the Upload Documents section. 

14. For each document that you want to attach to the filing, do the following: 

a. In the Description field, accept the default description (Main Document), or optionally, type a 
description. 

b. Click the Browse button to find and select the PDF file to attach. 

Make sure you upload all the PDF files that make up your filing (for example, motion and declaration). An 
example of the Upload Documents section, with two PDF files is shown below. 
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15. In the Service section, in the date field, type the service date for the filing, and in the Service Certification 
section, from the drop-down list, select the value that certifies that you notified all parties not registered 
for electronic filing with notice of the filing. 
 
An example is shown below. You cannot continue your filing until you select a value in the Service 
Certification section. 
 

 
16. Click the Continue button. 

 
The Docket Text section is added to the page and shows the final docket text.  

17. Click the Continue button. 
 
The Final Review section opens. This is the “point of no return.” 

18. Click the Submit button to confirm your filing.  
 
A message dialog box opens to let you know that the filing was completed. 

19. Click the OK button. 
 
A browser window or tab opens with the notice of docket activity for your filing.  
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Filing a Response to a Motion 
This topic describes the steps for filing an unopposed motion to extend time to file an answering brief and is 
intended to give you a quick overview of the steps you need to complete to file a motion.  

1. In the CM/ECF landing page, in the menu bar, click Filing. 

2. In the File a Document page, in the Case Number field, type the number of the case for which you are 
entering the filing and press the Tab key. 

3. In the Type of Document field, type response to find all document types that contain the string 
“response” in the description. 
 
An example of the result is shown below. 
 

 
 

4. Use the scroll bar in the Type of Document list to find Response to Motion/Form. 

5. Click Response to Motion/Form  to select it. 
 
The type of document you selected is highlighted in a different color to show that it is selected. 

6. Click the Continue button. 

7. Carefully review the information in the warning dialog box, select the Continue checkbox, and click the OK 
button. 
 
The File a Document | Response to Motion/Form page opens. It has additional fields divided into sections 
to allow you to enter details for the filing.  

8. In the Party Filer section, select the party you represent by clicking the party in the list. 
 
As soon as you click the row, the system adds the party to the Selected list in the Party Filer section 
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9. Scroll down, and in the Related Entries section, select the motion to which you are responding by clicking 
the row for the filing.  
 
TIP: You can click the red arrow to expand the contents in the Entry column to see the full docket text (as 
shown for the highlighted motion below). You can click the document or lock icon in the Doc column to 
see the document that is attached to the entry (PACER fees apply). A lock icon instead of a document icon 
means that the document or documents attached to the filing are visible only to case participants. If you 
do not see the motion/form you want to respond to, send an email to the help desk at 
cmecf_ca9help@ca9.uscourts.gov.  
 
In the image below, the motion filed on 11/26/2018 by the Appellee is selected.  
 

 
 

10. Click the Continue button at the bottom of the page.  
 
The system collapses the completed sections and adds new sections that you must complete to continue. 
You can reopen a section by clicking the arrow to the left of the label for the section.  
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11. (Optional) In the Optional Response Type section, select the value that matches the type of response you 
are filing: joining, non-opposing, opposing, or supporting.  
 
In this example, we are selecting opposing, as shown below. 
 

 
 

12. Scroll down until you can see the Upload Documents section. 

13. For each document that you want to attach to the filing, do the following: 

a. In the Description field, accept the default description (Main Document), or optionally, type a 
description. 

b. Click the Browse button to find and select the PDF file to attach. 

Make sure you upload all the PDF files that make up your filing (for example, motion and declaration). 

14. In the Service section, in the date field, type the service date for the filing, and in the Service Certification 
section, from the drop-down list, select the value that certifies that you notified all parties not registered 
for electronic filing with notice of the filing. 
 
An example is shown below. You cannot continue your filing until you select a value in the Service 
Certification section. 
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15. Click the Continue button. 
 
The Docket Text section is added to the page and shows the final docket text.  

16. Click the Continue button. 
 
The Final Review section opens. This is the “point of no return.” 

17. Click the Submit button to confirm your filing.  
 
A message dialog box opens to let you know that the filing was completed. 

18. Click the OK button. 
 
A browser window or tab opens with the notice of docket activity for your filing.  
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Filing a Motion and a Response to a Motion Together 
This topic describes the steps for filing a motion and a response to a motion in one filing  

1. In the CM/ECF landing page, in the menu bar, click Filing. 

2. In the File a Document page, in the Case Number field, type the number of the case for which you are 
entering the filing and press the Tab key. 

3. In the Type of Document field, type response to find all document types that contain the string 
“response” in the description. 
 
An example of the result is shown below. 
 

 
 

4. Click Motion and Response to Motion Together  to select it. 
 
The type of document you selected is highlighted in a different color to show that it is selected. 

5. Click the Continue button. 

6. Carefully review the information in the warning dialog box, select the Continue checkbox, and click the OK 
button. 
 
The File a Document | Motion and Response to Motion Together page opens. It has additional fields 
divided into sections to allow you to enter details for the filing.  

7. In the Party Filer section, select the party you represent by clicking the party in the list. 
 
As soon as you click the row, the system adds the party to the Selected list in the Party Filer section 

8. (Optional) In the Optional Modifier For Motion section, if this is not a standard motion, select a value from 
the drop-down list. . 
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9. Scroll down to the Requested Relief section and in the Relief field, type extend time to find all reliefs 
that contain the string “extend time” in the description. 
 
The system filters the list to match your criteria. Notice that each matching relief contains the words 
“extend time’” You will also notice that the scroll bar is enabled in the list of reliefs. This means that there 
are more reliefs than the ones currently shown. 

10. Use the scroll bar in the relief list until you see “motion to extend time to file brief” in the list, then click 
motion to extend time to file brief. 
 
As soon as you click the row, the system adds the relief to the Selected list in the Requested Relief section, 
as shown below. 
 

 
 
You can repeat this step for other reliefs. You may select more than one relief for a motion. In this 
example, only one relief is selected. 

11. Click the Continue button at the bottom of the page. 
 
The system collapses the completed sections and adds new sections that you must complete to continue.  
 
NOTE: The Type of Brief and New Requested Due Date sections appear because you are filing a motion to 
extend time to file a brief, in addition to the response to an already filed motion. 

12. In the Type of Brief section, select Reply from the drop-down list and in the New Requested Due Date, 
type the new due date you are requesting for the brief. 
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13. (Optional) In the Optional Response Type section, select the value that matches the type of response you 
are filing: joining, non-opposing, opposing, or supporting.  
 
In this example, we are selecting opposing, as shown below. 
 

 
 

14. Scroll down, and in the Related Entries section, select the motion to which you are responding by clicking 
the row for the filing.  
 
TIP: You can click the red arrow to expand the contents in the Entry column to see the full docket text. You 
can click the document or lock icon in the Doc column to see the document that is attached to the entry 
(PACER fees apply). A lock icon instead of a document icon means that the document or documents 
attached to the filing are visible only to case participants. If you do not see the motion/form you want to 
respond to, send an email to the help desk at cmecf_ca9help@ca9.uscourts.gov.  
 
In the image below, the motion filed on 11/26/2018 by the Appellee is selected.  
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15. Click the Continue button at the bottom of the page.  
 
The system collapses the completed sections and adds new sections that you must complete to continue. 
You can reopen a section by clicking the arrow to the left of the label for the section.  

16. Scroll down until you can see the Upload Documents section. 

17. For each document that you want to attach to the filing, do the following: 

a. In the Description field, accept the default description (Main Document), or optionally, type a 
description. 

b. Click the Browse button to find and select the PDF file to attach. 

Make sure you upload all the PDF files that make up your filing (for example, motion, response to motion, 
and declaration). 

18. In the Service section, in the date field, type the service date for the filing, and in the Service Certification 
section, from the drop-down list, select the value that certifies that you notified all parties not registered 
for electronic filing with notice of the filing. 
 
An example is shown below. You cannot continue your filing until you select a value in the Service 
Certification section. 
 

 
 

19. Click the Continue button. 
 
The Docket Text section is added to the page and shows the final docket text.  

20. Click the Continue button. 
 
The Final Review section opens. This is the “point of no return.” 

21. Click the Submit button to confirm your filing.  
 
A message dialog box opens to let you know that the filing was completed. 
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22. Click the OK button. 
 
A browser window or tab opens with the notice of docket activity for your filing.  
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Filing a Court Reporter Motion to Extend Time 
Before you start, review the FAQs developed specifically for court reporters at 
http://www.ca9.uscourts.gov/cmecf/faqs/courtreporters/. 

TIP: The Court has prepared a fill-in form, Form 21. Court Reporter Motion for Extension of Time to File 
Transcript, that you can use for your motions. Check the Court’s Forms page at 
http://www.ca9.uscourts.gov/forms or go to http://www.ca9.uscourts.gov/forms/form21.pdf. 

1. In the CM/ECF landing page, in the menu bar, click Filing. 

2. In the File a Document page, in the Case Number field, type the number of the case for which you are 
entering the filing and press the Tab key. 

3. In the Type of Document field, type reporter to find all document types that contain the string 
“reporter” in the description. 
 
An example of the result is shown below. 
 

 
 

4. Click Court Reporter Motion to Extend Time to select it. 
 
The type of document you selected is highlighted in a different color to show that it is selected. 

5. Click the Continue button. 

6. Carefully review the information in the warning dialog box, select the Continue checkbox, and click the OK 
button. 
 
The File a Document | Court Reporter Motion to Extend Time page opens. It has additional fields divided 
into sections to allow you to enter details for the filing.  
 

  

http://www.ca9.uscourts.gov/cmecf/faqs/courtreporters/
http://www.ca9.uscourts.gov/forms
http://www.ca9.uscourts.gov/forms/form21.pdf
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7. In the Court Reporter Filer section, select your name if it appears in the list.  
 
As soon as you click the row, the system adds the name to the Selected list in the Court Reporter Filer 
section.  
 
NOTE: If your name does not appear in the list, type it in the Enter Your Name ... section below the Court 
Reporter Filer section instead. 

8. Scroll down until you can see the Upload Documents section and do the following to upload your motion: 

a. In the Description field, accept the default description (Main Document), or optionally, type a 
description. 

b. Click the Browse button to find and select the PDF file to attach. 

TIP: Remember that a fill-in form is available here: http://www.ca9.uscourts.gov/forms/form21.pdf. 

9. In the Service section, in the date field, type the service date for the filing. 

10. In the Service Certification section, from the drop-down list, select the value that certifies that you 
notified all parties not registered for electronic filing with notice of the filing. 

11. Click the Continue button. 
 
The Docket Text section is added to the page and shows the final docket text. An example is shown below. 
 

 
 

12. Click the Continue button. 
 
The Final Review section opens. This is the “point of no return.” 

13. Click the Submit button to confirm your filing.  
 
A message dialog box opens to let you know that the filing was completed. 

14. Click the OK button. 
 
A browser window or tab opens with the notice of docket activity for your filing.  

http://www.ca9.uscourts.gov/forms/form21.pdf
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Filing a Petition for Rehearing 
Follow the instructions in this topic to request rehearing of an Opinion or a Memorandum Disposition. 

The instructions in this topic apply to the following types of filings: 

• Petition for Panel Rehearing (FRAP 40; 9th Cir. R. 40-1) 

• Petition for Rehearing En Banc (FRAP 35; 9th Cir. R. 35-1) 

• Combination Petition for Panel Rehearing/En Banc (FRAP 35, 40) 

CAUTION: If you want to request reconsideration of an Order, file a Motion for Reconsideration instead. 
 

1. In the CM/ECF landing page, in the menu bar, click Filing. 

2. In the File a Document page, in the Case Number field, type the number of the case for which you are 
entering the filing and press the Tab key. 

3. In the Type of Document field, type rehearing to find all document types that contain the string 
“rehearing” in the description. 
 
An example of the result is shown below. 
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4. Click the document type for the type of petition for rehearing you want to file: 

• To request a rehearing by panel only, click Petition for Panel Rehearing (FRAP 40; 9th Cir. R. 40-1). 

• To request a rehearing by en banc panel only, click Petition for Rehearing En Banc (FRAP 35; 9th Cir. R. 
35-1). 

• To request a rehearing by panel and en banc panel, click Petition for Panel Rehearing/En Banc 
Combined (FRAP 35, 40) 

The type of document you selected is highlighted in a different color to show that it is selected. An 
example, for Petition for Panel Rehearing/En Banc Combined (FRAP 35, 40), is shown below. 
 

 
 

5. Click the Continue button. 

6. Carefully review the information in the warning dialog box, select the Continue checkbox, and click the OK 
button. 
 
REMINDER: If you want to request reconsideration of an Order, click the OK button to return to the 
previous page, and find and select Motion for Reconsideration instead. 
 
The File a Document | type-of-petition-for-rehearing page opens. It has additional fields divided into 
sections to allow you to enter details for the filing.  
 

7. In the Party Filer section, select the party you represent by clicking the party in the list. 
 
As soon as you click the row, the system adds the party to the Selected list in the Party Filer section. 

8. From the drop-down list in the Requesting Rehearing of section, select memorandum or opinion. 



CM/ECF USER GUIDE 

74 

9. In the Date of Memorandum or Opinion field, type the date the memorandum or opinion was filed. 
 
The image below shows an example requesting rehearing of an opinion filed on 12/10/2018. 
 

 
 

10. Scroll down until you can see the Upload Documents section. 

11. For each document that you want to attach to the filing, do the following: 

a. In the Description field, accept the default description (Main Document), or optionally, type a 
description. 

b. Click the Browse button to find and select the PDF file to attach. 

Make sure you upload all the PDF files that make up your filing (for example, petition for rehearing, 
memorandum or opinion, and certificate of compliance). 
 
CAUTION: You are required to attach a copy of the opinion or memorandum disposition being challenged. 
If you do not attach a copy, your petition will be rejected. See 9th Cir. R. 40-1(c). 

12. In the Service section, in the date field, type the service date for the filing, and in the Service Certification 
section, from the drop-down list, select the value that certifies that you notified all parties not registered 
for electronic filing with notice of the filing. 
 
You cannot continue your filing until you select a value in the Service Certification section. 
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13. Click the Continue button. 
 
The Docket Text section is added to the page and shows the final docket text. An example of the docket 
text for a combined petition for panel and en banc rehearing is shown below. 
 

 
14. Click the Continue button. 

 
The Final Review section opens. This is the “point of no return.” 

15. Click the Submit button to confirm your filing.  
 
A message dialog box opens to let you know that the filing was completed. 

16. Click the OK button. 
 
A browser window or tab opens with the notice of docket activity for your filing.  
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Filing a Sealed Document 
Documents submitted using any of the sealed filing types will not be accessible online to the parties. The 
CM/ECF electronic notice of filing will not act to cause service of those documents under FRAP 25(c)(2) and 
Ninth Circuit Rule 25-5(f)(1). Circuit Rule 27-13(c) therefore requires an alternative method of serving the 
motion or notice to seal and the materials to be sealed, which is described in Ninth Circuit Rule 25-5(f)(2). 

NOTE: Sealed excerpts of record must be submitted in a separate transaction along with a motion or notice 
and the separate volume containing only the sealed documents. 

See the Rules page at http://www.ca9.uscourts.gov/rules/ to review the rules referred to above. 

All filings in this category must 

• include a Form 15. Certificate of Service  
(available here: http://www.ca9.uscourts.gov/forms/), and 

• be accompanied by the filing for which sealing is requested, or relate to a previously submitted filing for 
which sealing is requested. 

For notices of sealing in accordance with subsections (d) and (g) of Circuit Rule 27-13, you must include Form 
19. Notice of Sealing (available here: http://www.ca9.uscourts.gov/forms/).  

For notices of intent to file sealed documents publicly in accordance with subsection (f) of Circuit Rule 27-13, 
you must include Form 20. Notice of Intent to Unseal (available here: http://www.ca9.uscourts.gov/forms/).  

See Saving a Completed Fill-In Form for information about downloading a form and preparing the completed 
form for filing in CM/ECF. 

The following filing types are available in the Sealed Documents category: 

• Motion to File Document Under Seal and Submit Sealed Document 

• Motion to Maintain Under Seal 

• Notice of Filing Document Under Seal and Submit Sealed Document 

• Notice of Intent to File Publicly and Submit Document Under Seal 

• Notice to Maintain Under Seal 

• Presentence Report Under Seal 

http://www.ca9.uscourts.gov/rules/
http://www.ca9.uscourts.gov/forms/
http://www.ca9.uscourts.gov/forms/
http://www.ca9.uscourts.gov/forms/
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Working with Email Notices of Docket Activity 
A notice of docket activity is a notice that is generated whenever something is entered on the docket of a case. 
The top of the notice contains a disclaimer stating that public users may view the notice information once free 
of charge (“one free look”). After that, a fee will be assessed. 

The notice shows case information, docket text, the recipient names, and a hyperlink for the case number. In 
addition, the notice may include a link labeled Document(s). If you are logged in to PACER, clicking the case 
number hyperlink takes you to the Docket Report window from where you can generate a docket report. An 
example of a browser window with a notice of docket activity is shown below. 

NOTE: If you are not a party or attorney in a case, and you signed up to receive notices for cases of interest, 
the “one free look” does not apply.  
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Receiving Notices of Docket Activity in Text-Only Format 
If your noticing preference is set to Text instead of HTML, the notices of docket activity you receive will not 
include any hyperlinks. Instead, you will see a URL instead of a Document(s) link. In this case, you must access 
that URL in the same browser where you are reviewing the NDA, otherwise, you may lose your free look. An 
example of a text-only notice is shown below (the arrow is pointing to the URL you have to copy). 
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The Subject Line of a Notice of Docket Activity 
The subject line of a notice of docket activity shows the case number, the case title, and provides a short 
description of the activity that happened in the case. 

CAUTION: Even if the notice applies to several cases, the subject line of a notice of docket activity only lists one 
case number!  

For all filings entered in linked cases, only one case number will appear in the subject line of the notice of 
docket activity. The docket text lists all the cases at the end of the docket text. An example of a notice of 
docket activity for a motion and a response to a motion together is shown below. The subject line for this 
notice is “66-999 ABC Fiction Team v. AAA Fiction Widget Company Motion and Response 
to Motion Together”. The end of the docket text shows that the filing was entered in both 66-999 and 67-
999. 
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Saving Document(s) Referenced in a Notice of Docket Activity 
A Document(s) link appears in the notice if, and only if, one or more documents were attached to the activity 
in the docket. 

You can click the Document(s) link to view the document or documents that were attached. 

CAUTION: Remote electronic access to documents in Social Security cases and immigration matters is limited 
to the attorneys or parties in the case to protect the privacy of the individuals involved in those cases. You 
may inspect these files in person in the Clerk's office. If you are a party or attorney in the case, you can access 
documents in these cases only by using your PACER/e-filing username and password. See Federal Rule of 
Appellate Procedure 25(a)(5) and Federal Rule of Civil Procedure 5.2. 

In CM/ECF documents are attached in portable document format (PDF). This means that when you click a 
document link, the document opens in Adobe Reader or in another PDF-capable application on your system. 
For this document, we are assuming that you are using Adobe Reader. 

NOTE: If you are not a party or attorney in a case, and you signed up to receive notices for cases of interest, 
the “one free look” does not apply.  

To save a copy of a document attached to a notice of docket activity 

1. In the notice of docket activity, click the Document(s) link. 
 
NOTE: If more than one document is attached to the entry, a page opens with a number of links. There is 
one link for each attached document. In this case, click the link of the document that you want to open. 
 
The document opens in your web browser or in a separate Adobe Reader window, depending on your 
settings.  

2. Choose File > Save As (or Save A Copy, if Save As is not shown).  
-or- 
Click the Save a Copy button in the toolbar. 

3. In the Save As dialog box, enter the file name and location, and click the Save button.  
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Creating Cross-Document Hyperlinks in WordPerfect 
The topics below describe how to create a hyperlink in a PDF document, where the hyperlink links to another 
PDF document in a CM/ECF database. The document being referenced can be a document that was previously 
filed or a document that is being filed in the same transaction (filing) as the referencing document.  

CAUTION: Keep in mind that if you create hyperlinks in your pleadings, and those hyperlinks take the reader to 
another document on PACER, anyone viewing your filing will have to pay the standard PACER fees when 
accessing those other documents. 

Creating a Hyperlink to a Document Already Filed in a Case 
You can create a link to another document in any database in the Federal Courts: District, Bankruptcy (as of 
December 2006) or Appellate (as of July 2006, Version 1.3). 

1. Access CM/ECF and run the docket report for the case in which the document was filed. 

2. Locate the document among the docket entries. 

3. Copy the URL (the “address”) of the document to the clipboard by doing the following: 

a. Hover over the document link and click the right mouse button (the document link displays after the 
docket date and is represented by an icon or a number with an underscore, for example, 5). 

b. From the pop-up menu, choose Copy Shortcut, Copy Link Location, or Copy Link Address (the option 
you will see depends on your browser), 

CAUTION: DO NOT copy the URL from the browser’s address bar when the document is open. 
An example of the pop-up menu in Firefox is shown below. 
 

 
 

4. Open the word processing document. 
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5. In the document, highlight the citation text for which you want to create the hyperlink. 
 
An example is shown below. 
 

 
 

6. From the Tools menu, choose Hyperlink.  
 
The Hyperlink Properties dialog box opens. An example is shown below. 
 

 
 

7. Press Ctrl-V to paste the URL into the Document/Macro field. 

8. If the citation is to a specific page in the document, append a string to the URL to identify the page: 
?page=x  
 
NOTE: Make sure you type the exact PDF page number. 
 
For example: https://ecf.ca1.uscourts.gov/docs1/001010708409?page=23  
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NOTE: Because of an incompatibility between Internet Explorer and Adobe Acrobat, the page number 
pointer will not work if the user opens the document with Internet Explorer. 
 

9. Click the OK button. 
 
In the document, the hyperlink text is now underlined and blue (or the color that you specified for 
hyperlinks), indicating a hyperlink has been created.  

10. Save the document. 

11. Choose File > Publish to PDF. 
-or- 
Choose File > Publish to > PDF. 
 
CAUTION: Do not use the Print option in the word processing program. 
If you are using an earlier version of WordPerfect that does not have one of these Publish options, you 
must upgrade to Version 11 or higher. 

You are now ready to file your document and upload the PDF with hyperlinks. 

Creating Hyperlinks Between Documents in the Same Filing:  
Instead of linking to a previously-filed document, you can link a document to another document that you will 
be filing at the same time. For example, you could create a hyperlink from your main document to an 
attachment.  

When you create the link, it points to the referenced document where it exists on your local system or 
network and when the documents are filed in CM/ECF, the link is converted to an “address” in CM/ECF. 

1. Create PDF versions of any secondary documents, such as attachments or exhibits, that will be referenced 
by the main document.  

2. Open the main document in the word processing program. 
 
The main document is the document that will have hyperlinks to the secondary documents. 

3. In the main document, highlight the text for which you want to create the hyperlink to the secondary 
document. 

4. From the Tools menu, choose Hyperlink.  
 
The Hyperlink Properties dialog box opens.  

5. Click the folder icon to the right of the Document/Macro field. 
 
The Select File window opens. 

6. Navigate to and select the PDF file that you want to link to and click the Select button. 
 
The Document/Macro field in the Hyperlink Properties dialog box now shows the file you selected. 

7. Click the OK button. 
 



CM/ECF USER GUIDE 

84 

8. If the citation is to a specific page in the document, append a string to the value in the field to identify the 
page: ?page=x  
 
NOTE: Make sure you type the exact PDF page number. 
 
For example:  C:\MyFiles\Exhibit-A.pdf?page=23  
 
NOTE: Because of an incompatibility between Internet Explorer and Adobe Acrobat, the page number 
pointer will not work if the user opens the document with Internet Explorer. 

9. Click the OK button. 
 
The hyperlink text is now underlined and blue (or the color that you specified for hyperlinks), indicating a 
hyperlink has been created.  

10. Save the document. 

11. Choose File > Publish to PDF. 
 
-or- 
 
Choose File > Publish to > PDF. 
 
CAUTION: Do not use the Print option in the word processing program. 
If you are using an earlier version of WordPerfect that does not have one of these Publish options, you 
must upgrade to Version 11 or higher. 

You are now ready to file your documents and upload the PDF with hyperlinks. 
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Creating Cross-Document Hyperlinks in MS Word 
The topics below describe how to create a hyperlink in a PDF document, where the hyperlink links to another 
PDF document in a CM/ECF database. The document being referenced can be a document that was previously 
filed or a document that is being filed in the same transaction (filing) as the referencing document.  

CAUTION: Keep in mind that if you create hyperlinks in your pleadings, and those hyperlinks take the reader to 
another document on PACER, anyone viewing your filing will have to pay the standard PACER fees when 
accessing those other documents. 

Creating a Hyperlink to a Document Already Filed in a Case 
You can create a link to another document in any database in the Federal Courts: District, Bankruptcy (as of 
December 2006) or Appellate (as of July 2006, Version 1.3). 

1. Access CM/ECF and run the docket report for the case in which the document was filed. 

2. Locate the document among the docket entries. 

3. Copy the URL (the “address”) of the document to the clipboard by doing the following: 

a. Hover over the document link and click the right mouse button (the document link displays after the 
docket date and is represented by an icon or a number with an underscore, for example, 5). 

b. From the pop-up menu, choose Copy Shortcut, Copy Link Location, or Copy Link Address (the option 
you will see depends on your browser), 

CAUTION: DO NOT copy the URL from the browser’s address bar when the document is open. 
An example of the pop-up menu in Firefox is shown below. 
 

 
4. Open the word processing document. 
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5. In the document, highlight the citation text for which you want to create the hyperlink. 
 
An example is shown below. 
 

 
 

6. On the Insert tab, click Link. 
 
The Insert Hyperlink dialog box opens. The Text to display field contains the text you selected in the 
previous step. 

7. Press Ctrl-V to paste the URL into the Address field. 
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8. If the citation is to a specific page in the document, append a string to the URL to identify the page: 
?page=x  
 
NOTE: Make sure you type the exact PDF page number. 
 
For example: https://ecf.ca1.uscourts.gov/docs1/001010708409?page=23  
 
NOTE: Because of an incompatibility between Internet Explorer and Adobe Acrobat, the page number 
pointer will not work if the user opens the document with Internet Explorer. 
 
An example of the Insert Hyperlink dialog box with the Address field completed is shown below. 
 

 
 

9. Click the OK button. 
 
In the document, the hyperlink text is now underlined and blue (or the color that you specified for 
hyperlinks), indicating a hyperlink has been created.  

10. Save the document. 
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11. If you are using a version of Word that has an ACROBAT tab, click the tab, then click Create PDF. 
 
-or- 
 
If you are using Word but do not have an ACROBAT menu, close the Word file and follow the steps below.  

a. Open Adobe Acrobat.  

b. From the File menu, click Create PDF, then click From File. 
A navigation dialog box opens.  

c. In the navigation dialog box, find and select the document that you want to convert to PDF, then click 
the Open button. 
A series of dialog boxes open while the document is converted to PDF. When the conversion is 
complete, the document is displayed in an Adobe Acrobat window, with active hyperlinks (the ones 
you defined in the Word document). 

d. Save the PDF file in a directory of your choice. 

You are now ready to file your document and upload the PDF with hyperlinks. 

Creating Hyperlinks Between Documents in the Same Filing:  
Instead of linking to a previously filed document, you can link a document to another document that you will 
be filing at the same time. For example, you could create a hyperlink from your main document to an 
attachment.  

When you create the link, it points to the referenced document where it exists on your local system or 
network and when the documents are filed in CM/ECF, the link is converted to an “address” in CM/ECF. 

1. Create PDF versions of any secondary documents, such as attachments or exhibits, that will be referenced 
by the main document.  

2. Open the main document in the word processing program. 
 
The main document is the document that will have hyperlinks to the secondary documents. 

3. In the main document, highlight the text for which you want to create the hyperlink to the secondary 
document. 

4. On the Insert tab, click Link. 
The Insert Hyperlink dialog box opens. The Text to display field contains the text you selected in the 
previous step. 

5. Navigate to and select the PDF file that you want to link to. 
 
The Address field in the Insert Hyperlink dialog box now shows the file you selected. 
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6. If the citation is to a specific page in the document, append a string to the value in the field to identify the 
page: ?page=x  
 
NOTE: Make sure you type the exact PDF page number. 
 
For example:  C:\MyFiles\Exhibit-A.pdf?page=23  
 
NOTE: Because of an incompatibility between Internet Explorer and Adobe Acrobat, the page number 
pointer will not work if the user opens the document with Internet Explorer. 

7. Click the OK button. 
 
The hyperlink text is now underlined and blue (or the color that you specified for hyperlinks), indicating a 
hyperlink has been created.  

8. Save the document. 
 

9. If you are using a version of Word that has an ACROBAT tab, click the tab, then click Create PDF. 
 
-or- 
 
If you are using Word but do not have an ACROBAT menu, close the Word document and follow the steps 
below.  

a. Open Adobe Acrobat.  

b. From the File menu, click Create PDF, then click From File. 
A navigation dialog box opens.  

c. In the navigation dialog box, find and select the document that you want to convert to PDF, then click 
the Open button. 
A series of dialog boxes open while the document is converted to PDF. When the conversion is 
complete, the document is displayed in an Adobe Acrobat window, with active hyperlinks (the ones 
you defined in the Word document). 

d. Save the PDF file in a directory of your choice. 

You are now ready to file your documents and upload the PDF with hyperlinks. 
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Using CM/ECF for Bar Admission 
You can check your bar status via CM/ECF, and if you are not admitted, you can submit your application for 
admission. You can also request duplicate admission certificates and certificates of good standing. 

Submitting an Application for Admission with Fee Payment 
Before you start, make sure you have your application for admission and any supporting documents ready to 
upload. All documents must be in “flat” PDF format (if you can still update the fields, it is not “flat”). 

CAUTION: You may not, under any circumstances, submit an application for admission for another attorney.  

1. In the CM/ECF landing page, in the menu bar, click Utilities, then click Bar Admission. 
 
The CM/ECF landing page is replaced with a new page titled Bar Admission. An example is shown below. 
 
NOTE: If you are already admitted in the U.S. Court of Appeals for the 9th Circuit, you will not see the Pay 
Fee and Submit Application button. If you do, and you are sure you are already admitted, contact the 
admissions clerk at 415-355-8000 to have the system updated. 
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If you were previously admitted as a federal government attorney (fee waived), and you want to submit 
your application for admission without a fee waiver (so you can receive a duplicate admission certificate), 
the page you see will be different from the one shown earlier. Instead, you will see a page with an Update 
Fee button, as shown below. 
 

 
 
If this applies to you, do the following: 

a. Click the Update Fee button. 
 
The Update Fee button changes to a Pay Fee and Submit Application button, and the Submit 
Documents section is enabled. 

b. Go to step 3 below. 

2. Complete the State Bar Number and State of Residence fields. 

3. In the Submit Documents section, for each document that you want to attach to the submission 
(application for admission, supporting documents), do the following: 

a. In the Description field, accept the default description (Main Document), or optionally, type a 
description. 

b. Click the Browse button to find and select the PDF file to attach. 

An example of the Submit Documents section with one uploaded document is shown below. 
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4. Click the Pay Fee and Submit Application button to submit your payment and the files you attached.  
 
NOTE: If you were previously admitted as a federal government attorney, the button is labeled Pay Fee 
and Submit Documents.  
 
The page where you clicked the Pay Fee button is replaced with a PACER Login page. Your username is 
already filled in. You must enter your password again to confirm your identity. This is a safety measure. An 
example of the PACER Login page is shown below. 
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5. In the Password field, type your password, then click the Login button. 
 
The PACER page is updated to show the Pay Attorney Admission/Renewal Fees for U.S. Court of Appeals, 
Ninth Circuit - NextGen area, where you can select a credit card on file, or enter a new credit card.  
 
If you do not have a credit card on file with PACER, the page shown below opens. 
 

 
 

6. If you already have a credit card on file with PACER, under Select a Payment Method, select the option 
button for the card on file and go to step 8, or go to step 7 to enter a new credit card. 
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7. If you do not have a credit card on file with PACER or if you chose to enter a new credit card, in the Enter 
Payment Method section, enter the information needed for the credit card, as shown below. 
 

 
 

8. Click the Next button. 
 
A Court Specific section is added to the page.  
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9. Complete the required fields in the Court Specific section. 
 
An example is shown below. 
 

 
 
 
NOTE: The Case Number field does not apply for applications for admission. 

10. In the Email Receipt section, if you want the confirmation email to be sent to a different email address 
than the one linked to your PACER and e-filing account, enter that email address in the Email and Confirm 
Email fields. 

11. In the Authorization section, select the checkbox to authorize the charge on the credit card and click the 
Submit button. 
 
PACER processes the payment, and when it is complete, a receipt is shown. An example of a receipt is 
shown below. 
 

 
 

12. To review what you just submitted, see Reviewing Your Submissions and Payments. 
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Submitting an Application for Admission without Fee Payment (Fee Waiver) 
Before you start, make sure you have your application for admission and any supporting documents ready to 
upload. All documents must be in “flat” PDF format (if you can still update the fields, it is not “flat”).  

CAUTION: You may not, under any circumstances, submit an application for admission for another attorney.  

1. In the CM/ECF landing page, in the menu bar, click Utilities, then click Bar Admission. 
 
The CM/ECF landing page is replaced with a new page titled Bar Admission. An example is shown below. 
 
NOTE: If you are already admitted in the U.S. Court of Appeals for the 9th Circuit, you will not see the Pay 
Fee and Submit Application button. If you do, and you are sure you are already admitted, contact the 
admissions clerk at 415-355-8000 to have the system updated. 
 

 
 

2. Complete the State Bar Number and State of Residence fields. 
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3. From the Reason for Fee Waiver drop-down list, select the appropriate value: 9th Circuit Law Clerk 
or Federal Government Attorney. 
 
As soon as you select a fee waiver reason, the Pay Fee and Submit Application button changes to a Submit 
Application button. An example is shown below. 
 

 
 

4. In the Submit Documents section, for each document that you want to attach to the submission 
(application for admission, supporting documents), do the following: 

a. In the Description field, accept the default description (Main Document), or optionally, type a 
description. 

b. Click the Browse button to find and select the PDF file to attach. 

5. Click the Submit Application button.  

6. To review what you just submitted, see Reviewing Your Submissions and Payments. 
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Requesting and Paying for a Certificate of Good Standing 
You can use CM/ECF to request and pay for certificate of good standing.  

1. In the CM/ECF landing page, in the menu bar, click Utilities, then click Pay Miscellaneous Fee, then click 
Certificate of Good Standing. 
 
The CM/ECF landing page is replaced with a new page titled Certificate of Good Standing. An example is 
shown below. 
 

 
 

2. In the Quantity field, enter the number of certificates you want to receive from the Court. 
 
The system automatically updates the Amount field if you are requesting more than one certificate. 

3. Click the Browse button to find and select a PDF with your current contact information. 

4. Click the Pay Fee and Submit button to complete your payment and submit the request to the Court. 

5. Follow the payment steps in Submitting an Application for Admission with Fee Payment to complete the 
payment at PACER. 

6. To review what you just submitted, see Reviewing Your Submissions and Payments. 
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Requesting and Paying for a Duplicate Admission Certificate 
You can use CM/ECF to request and pay for duplicate admission certificate. 

CAUTION: If you were admitted as a federal government attorney (fee waived), you cannot order a duplicate 
admission certificate without paying the full admission fee. If you are in this situation, submit your application 
for admission and payment using CM/ECF (see Submitting an Application for Admission With Fee Payment) or 
call the Attorney Admissions clerk at the Court at 415-355-7800. 

1. In the CM/ECF landing page, in the menu bar, click Utilities, then click Pay Miscellaneous Fee, then click 
Dupl. Admission Certificate. 
 
The CM/ECF landing page is replaced with a new page titled Dupl. Admission Certificate. An example is 
shown below. 
 

 
 

2. In the Quantity field, enter the number of certificates you want to receive from the Court. 
 
The system automatically updates the Amount field if you are requesting more than one certificate. 

3. Click the Browse button to find and select a PDF with your current contact information. 

4. Click the Pay Fee and Submit button to complete your payment and submit the request to the Court. 
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5. Follow the payment steps in Submitting an Application for Admission with Fee Payment to complete the 
payment at PACER. 

6. To review what you just submitted, see Reviewing Your Submissions and Payments. 
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Updating Your Account 
You must update most of your account information and preferences at the PACER website. Do not send 
changes of address or name changes to the Court.  

Updating the Sort Order of the Daily Summary Notices 
If you receive a daily summary of notices instead of a notice with each transaction, you can change the sort 
order of those daily summary notices. 

1. In the CM/ECF landing page, in the menu bar, click Utilities then click Update My Account. 
 
The Update My Account page opens. An example is shown below. 
 

 
 

2. In the Noticing Preferences section, from the Sorted by drop-down list, select how you want the entries in 
the daily summary NDA to be sorted: 

a. Case/transaction time - by case and then within each case, by transaction time  

b. Transaction time - by transaction time only  

NOTE: If the Sorted by drop-down list is not enabled (as above), you are receiving notices for each 
transaction instead of receiving a daily summary and this setting does not apply to you. 

3. Click the Save button in the Noticing Preferences section. 

Showing or Hiding the PDF Header on Documents Retrieved via PACER 
The Show PDF Header checkbox in the Account Information section allows you to set a default for whoing or 
hiding the PDF header when you retrieve documents via PACER. You can still decide to change that setting 
when you are retrieving the document(s). 
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Updating Your Account Information at PACER 
You must update all other account information and preferences at PACER. 

1. In the CM/ECF landing page, in the menu bar, click Utilities then click Update My Account then click the 
PACER Service Center link at the bottom of the page. 
 
-or- 
 
Navigate to https://pacer.psc.uscourts.gov/pscof/manage/maint.jsf. 

2. At the PACER LOGIN page that opens, enter your PACER password and click the Login button. 
 
The Manage My Account page (at PACER) opens. This page has four tabs: Settings, Maintenance, 
Payments, and Usage. An example is shown below. 
 

 
 
You can now update your account. 

3. Click the Maintenance tab to update your name, physical address, email addresses, and other information. 

4. Follow the instructions at the PACER website to submit your updates. 

 

https://pacer.psc.uscourts.gov/pscof/manage/maint.jsf
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Filing Types and Categories 
This topic provides a complete list of the types of documents and filing categories available to you. CM/ECF 
lets you filter the types of documents you can file, without having to select a category first.  

See Finding and Selecting a Filing Type to see how you can filter the list of available filing types. 

NOTE: For the following filing types, you cannot attach a PDF. All the information the court needs is gathered 
from your entries and selections during the filing. 

• Non-Opposition to Motion/Form/Notice 

• Notice of Appearance or Substitution of Counsel 

• Notice of Withdrawal of Counsel 

• Streamlined Request to Extend Time to File Brief 

When you file an Acknowledgment of Hearing Notice, you should only attach a PDF if you are requesting a 
specific disability accommodation. 

Service for Filing Types Without Documents 
If you must serve parties that are not registered for Appellate Electronic Filing, print the Notice of Docket 
Activity that opens at the end of the transaction and mail it to those parties as notice of your filing.  
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Filing Types (Type of Document) 
The following is an alphabetical list of all the document types available to you. See Finding and Selecting a 
Filing Type for more information about finding a value in the Type of Document list.  

(*) Indicates filing types for which you cannot attach a PDF. All the information the court needs is gathered 
from your entries and selections during the filing. 

• 28(j) Letter (Citation of Supplemental Authorities) 

• Acknowledgment of Hearing Notice (you should only attach a PDF if you are requesting a specific disability 
accommodation) 

• Affidavit Accompanying In Forma Pauperis Motion (Form 4) 

• Agency Certified List 

• Amicus Brief by Government or with Consent 

• Answer or Response to Petition for Rehearing/En Banc 

• Answer to Original Petition 

• Application for Fees Under EAJA 

• Bill of Costs (Form 10) 

• Brief and Prospective Amicus or Intervenor Motion Together 

• Brief on the Merits (Opening, Answering, Reply, Supplemental, etc) 

• CJA Form 23 Financial Affidavit 

• Certification for Law Student Representation Form 

• Client Authorization of Law School Representation 

• Corporate Disclosure Statement (FRAP 26.1) 

• Correspondence to Court 

• Court Reporter Correspondence to Court 

• Court Reporter Motion to Extend Time 

• Errata to Brief 

• Errata to Excerpts of Record 

• Excerpts of Record 

• FRAP 9(a) Memorandum 

• Immigration Certified Administrative Record (EOIR/DHS) 

• Joinder Letter in Lieu of Amicus Brief (CR 29-1 Note) 

• Joinder to Brief 

• Mediation Questionnaire 

• Motion and Response to Motion Together 
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• Motion for Reconsideration from Dispositive Order 

• Motion for Reconsideration from Non-Dispositive Order 

• Motion for any Type of Relief (Other than Reconsideration or to Seal) 

• Motion to File Document Under Seal and Submit Sealed Document 

• Motion to Maintain Under Seal 

• Non-Opposition to Motion/Form/Notice (*) 

• Notice of Appearance or Substitution of Counsel (*) 

• Notice of Filing Document Under Seal and Submit Sealed Document 

• Notice of Intent to File Publicly and Submit Document Under Seal 

• Notice of Reporter Default (9th Cir. R. 11-1.2) 

• Notice of Withdrawal of Counsel (*) 

• Notice to Maintain Under Seal 

• Pay Fee for Agency Petition/Petition for Writ of Mandamus 

• Pay Fee for Appeal from Bankruptcy Appellate Panel 

• Pay Sanction 

• Petition for Panel Rehearing (FRAP 40; 9th Cir. R. 40-1) 

• Petition for Panel Rehearing/En Banc Combined (FRAP 35, 40) 

• Petition for Rehearing En Banc (FRAP 35; 9th Cir. R. 35-1) 

• Presentence Report Under Seal 

• Prospective Amicus or Intervenor Motion 

• Reply to Answer to Original Petition 

• Reply to Response to Court Order 

• Reply to Response to FRAP 9(a) Memorandum 

• Reply to Response to Motion 

• Reply to Response to Order to Show Cause 

• Reply to Response to Petition for Rehearing/En Banc 

• Response to Case Being Considered for Oral Argument 

• Response to Court Order 

• Response to FRAP 9(a) Memorandum 

• Response to Motion/Form 

• Response to Order to Show Cause 

• Social Security Certified Administrative Record 
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• Status Report Required by Court Order 

• Streamlined Request to Extend Time to File Brief (*) 

• Supplemental Petition 

• Tax Court Record (U.S. Tax Court) 

(*) Indicates filing types for which you cannot attach a PDF. All the information the court needs is gathered 
from your entries and selections during the filing. 
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Filing Categories 
The following categories are available: 

• Appeals Pursuant to FRAP 9(a) 

• Briefs 

• Correspondence/Status Reports 

• Court Reporters 

• Forms/Notices/Disclosures 

• Motions/Responses/Replies 

• Original Petitions 

• Pay Fees 

• Prospective Amici and Intervenors 

• Rehearing/Reconsideration 

• Sealed Documents 

Appeals Pursuant to FRAP 9(a) 
• FRAP 9(a) Memorandum 

• Reply to Response to FRAP 9(a) Memorandum 

• Response to FRAP 9(a) Memorandum 

NOTE: To file a motion to extend time to file a FRAP 9(a) memorandum, you must file a motion, and then 
select the motion to extend time to file FRAP 9a Memorandum relief. See Filing a Motion for step-by-step 
instructions. 

Briefs 
• 28(j) Letter (Citation of Supplemental Authorities) 

• Brief on the Merits (Opening, Answering, Reply, Supplemental, etc) 

• Errata to Brief 

• Errata to Excerpts of Record 

• Excerpts of Record 

• Joinder Letter in Lieu of Amicus Brief (CR 29-1 Note) 

• Joinder to Brief 

• Motion to File Document Under Seal and Submit Sealed Document 

• Motion to Maintain Under Seal 

• Notice of Filing Document Under Seal and Submit Sealed Document 

• Notice of Intent to File Publicly and Submit Document Under Seal 
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• Notice to Maintain Under Seal 

• Presentence Report Under Seal 

• Streamlined Request to Extend Time to File Brief 

Correspondence/Status Reports 
• 28(j) Letter (Citation of Supplemental Authorities) 

• Correspondence/Letter to Court 

• Court Reporter Correspondence to Court 
 
See Court Reporters for additional information. 

• Notice of Reporter Default (9th Cir. R. 11-1.2) 

• Response to Case Being Considered for Oral Argument 

• Status Report Required by Court Order 

Court Reporters 
• Court Reporter Correspondence to Court 

• Court Reporter Motion to Extend Time 

• Notice of Reporter Default (9th Cir. R. 11-1.2) 

Forms/Notices/Disclosures 
TIP: Download fill-in forms from the Court’s website: http://www.ca9.uscourts.gov/forms. Save the form you 
want to your hard drive. You must have Adobe Acrobat to save a fill-in form. If you do not have Adobe 
Acrobat, you may scan the filled in form to attach it to your filing. 

• Acknowledgment of Hearing Notice 

• Affidavit Accompanying In Forma Pauperis Motion (Form 4) 

• Agency Certified List 

• Application for Fees Under EAJA 

• Bill of Costs (Form 10) 

• CJA Form 23 Financial Affidavit 

• Certification for Law Student Representation Form 

• Client Authorization of Law School Representation 

• Corporate Disclosure Statement (FRAP 26.1) 

• Immigration Certified Administrative Record (EOIR/DHS) 
 
NOTE: This filing type may only be used by the Executive Office of Immigration Review and the 
Department of Homeland Security/Office of Immigration Litigation. 

• Mediation Questionnaire 

http://www.ca9.uscourts.gov/forms
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• Non-Opposition to Motion/Form/Notice 

• Notice of Appearance or Substitution of Counsel 

• Notice of Filing Document Under Seal and Submit Sealed Document 

• Notice of Intent to File Publicly and Submit Document Under Seal 

• Notice of Reporter Default (9th Cir. R. 11-1.2) 

• Notice of Withdrawal of Counsel 

• Notice to Maintain Under Seal 

• Response to Motion/Form 

• Social Security Certified Administrative Record 

• Tax Court Record (U.S. Tax Court) 
 
NOTE: This filing type may only be used by the United States Tax Court. 

Motions/Responses/Replies 
• Answer to Original Petition 

• Court Reporter Motion to Extend Time 
 
See Court Reporters for additional information. 

• Motion and Response to Motion Together 
 
For a list of the types of motions that you can file, see Reliefs Available When Filing a Motion. 

• Motion for Reconsideration from Dispositive Order 

• Motion for Reconsideration from Non-Dispositive Order 

• Motion for any Type of Relief (Other than Reconsideration or to Seal) 
 
For a list of the types of motions that you can file, see Reliefs Available When Filing a Motion. 

• Motion to File Document Under Seal and Submit Sealed Document 

• Motion to Maintain Under Seal 

• Non-Opposition to Motion/Form/Notice 

• Notice of Intent to File Publicly and Submit Document Under Seal 

• Notice to Maintain Under Seal 

• Reply to Answer to Original Petition 

• Reply to Response to Court Order 

• Reply to Response to Motion 

• Reply to Response to Order to Show Cause 
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• Response to Case Being Considered for Oral Argument 

• Response to Court Order 

• Response to Motion/Form 

• Response to Order to Show Cause 

• Streamlined Request to Extend Time to File Brief 

• Supplemental Petition 

Reliefs Available When Filing a Motion 
You select the type of motion using the Relief area.  

Selecting Reliefs for a Filing provides step-by-step instructions on how to use the Relief area. 

• motion for 46-5 exemption 

• motion for appointment of counsel (Criminal or Habeas Corpus) 

• motion for appointment of pro bono counsel (Civil or Agency) 

• motion for attorney fees 

• motion for bail pending appeal or trial 

• motion for certificate of appealability 

• motion for certification to state supreme court 

• motion for injunction pending appeal 

• motion for miscellaneous relief (to be used only if no other relief applies) 

• motion for sanctions 

• motion for summary affirmance 

• motion for summary disposition 

• motion for summary reversal 

• motion to assign case to prior panel 

• motion to become amicus 

• motion to compel supplementation of excerpts of record 

• motion to complete production of reporters transcript at government expense 

• motion to consolidate cases 

• motion to continue hearing 

• motion to dismiss case for failure to prosecute under Circuit Rule 42-1 

• motion to dismiss for lack of jurisdiction 

• motion to dismiss party from case 

• motion to dismiss the case 



CM/ECF USER GUIDE 

111 

• motion to dismiss the case voluntarily pursuant to rule 42b 

• motion to expedite case 

• motion to extend time to comply with order 

• motion to extend time to file COA request 

• motion to extend time to file FRAP 9a memorandum 

• motion to extend time to file Mediation Questionnaire 

• motion to extend time to file agency record 

• motion to extend time to file amicus brief 

• motion to extend time to file appellant designation of reporters transcript 

• motion to extend time to file appellee designation of reporters transcript 

• motion to extend time to file appendix 

• motion to extend time to file bill of costs 

• motion to extend time to file brief 

• motion to extend time to file intervenor brief 

• motion to extend time to file opposition 

• motion to extend time to file petition for rehearing 

• motion to extend time to file record on appeal 

• motion to extend time to file reply 

• motion to extend time to file reporters transcript 

• motion to extend time to file response 

• motion to file a late brief 

• motion to file addendum 

• motion to file appendix 

• motion to file joint brief 

• motion to file late opposition (to file motion and opposition together) 

• motion to file late petition for rehearing (to file motion and petition for rehearing on same day) 

• motion to file nonstandard brief 

• motion to file oversized brief 

• motion to file oversized petition for rehearing 

• motion to file substitute or corrected brief 

• motion to file supplemental brief 

• motion to file supplemental briefing for petition for rehearing 
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• motion to hear case with other case 

• motion to intervene 

• motion to join in existing brief 

• motion to lift stay of appellate proceedings 

• motion to lift stay of removal/deportation 

• motion to present oral argument by video 

• motion to proceed in forma pauperis 

• motion to recall mandate 

• motion to refer case to mediation 

• motion to reinstate case after FRAP 42-1 dismissal 

• motion to remand case 

• motion to request publication of memorandum disposition 

• motion to reschedule oral argument 

• motion to stay appellate proceedings 

• motion to stay appellate proceedings pending settlement 

• motion to stay lower court action 

• motion to stay removal/deportation 

• motion to stay the mandate 

• motion to strike portion or whole of document 

• motion to submit case on briefs 

• motion to substitute counsel 

• motion to substitute party 

• motion to supplement or amend Mediation Questionnaire 

• motion to supplement or amend designation of reporters transcript 

• motion to supplement record on appeal 

• motion to take judicial notice 

• motion to transfer appeal to other circuit 

• motion to transmit exhibit 

• motion to unseal document 

• motion to waive filing of Mediation Questionnaire 

• motion to waive filing of excerpts of record 

• motion to withdraw as counsel 
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Original Petitions 
• Answer to Original Petition 

• Reply to Answer to Original Petition 

• Supplemental Petition 

Pay Fees 
• Pay Fee for Agency Petition/Petition for Writ of Mandamus 

 
CAUTION: If you filed a Notice of Appeal in the District Court, the Bankruptcy Court, or the Tax Court, you 
must pay the filing and appeal fees in that court. 

• Pay Fee for Appeal from Bankruptcy Appellate Panel 
 
CAUTION: If you filed a Notice of Appeal in the District Court, the Bankruptcy Court, or the Tax Court, you 
must pay the filing and appeal fees in that court. 

• Pay Sanction 

Prospective Amici and Intervenors 
• Amicus Brief by Government or with Consent 

 
CAUTION: You may only use this filing type if the party you represent is a government agency or if you 
have written consent by all parties to file this amicus brief. If you use this filing type in error, the clerk will 
not be able to process the filing and you will have to redo your filing using the correct filing type and 
include a motion with the filing. 

• Brief and Prospective Amicus or Intervenor Motion Together 

• Corporate Disclosure Statement (FRAP 26.1) 

• Joinder Letter in Lieu of Amicus Brief (CR 29-1 Note) 

• Prospective Amicus or Intervenor Motion 

Types of Motions Available When Filing a Prospective Amicus or Intervenor Motion 
You select the type of motion using the Relief area. Selecting Reliefs for a Filing provides step-by-step 
instructions on how to use the Relief area. 

• motion to become amicus 

• motion to extend time to file amicus brief 

• motion to extend time to file intervenor brief 

• motion to intervene 

Rehearing/Reconsideration 
• Answer or Response to Petition for Rehearing/En Banc 

• Motion for Reconsideration from Dispositive Order 

• Motion for Reconsideration from Non-Dispositive Order 
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• Petition for Panel Rehearing (FRAP 40; 9th Cir. R. 40-1) 

• Petition for Panel Rehearing/En Banc Combined (FRAP 35, 40) 

• Petition for Rehearing En Banc (FRAP 35; 9th Cir. R. 35-1) 

• Reply to Response to Petition for Rehearing/En Banc 

Sealed Documents 
See Filing a Sealed Document before you attempt to submit a sealed filing. 

• Motion to File Document Under Seal and Submit Sealed Document 

• Motion to Maintain Under Seal 

• Notice of Filing Document Under Seal and Submit Sealed Document 

• Notice of Intent to File Publicly and Submit Document Under Seal 

• Notice to Maintain Under Seal 

• Presentence Report Under Seal 
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